[image: image1.png]Hi'éaftware




HiSoftware JITI Builder™ Office

User’s Guide
Hiawatha Island Software Company, INC

6 Chenell Drive

Concord, New Hampshire, 03301 USA

(603) 229-3055

Table of Contents
Copyright Information
5
Introduction
6
An Introduction to JITI Builder Office
6
JITI Builder
6
JITI Verify
6
metaSearcher
6
metaContents Builder
6
HiSoftware Product Support
7
Registering Your Software
7
Necessary Information for Technical Support
8
The Best Ways to Contact Technical Support
8
1. Product Documentation
8
2. Internet
9
3. Email
9
4. Fax
9
Contacting Hiawatha Island Software Company
10
Support via Internet or Email
10
Technical Support
10
Sales, Marketing and Licensing
10
Installation
11
System Requirements
11
How we Install…
11
Directory Structure
12
Install Check List
13
Performing Installation for File Downloaded from the Web
13
Installation Steps from CD-ROM or Extracted Web File:
15
Section 2 – JITI Builder Office
20
Understanding how the program works
20
Launching the program
20
Parts of the main screen
21
The Menu
22
Explorer Style Interface
22
Using JITI Builder
23
Completing Step 1 of JITI Builder
24
Parts of the screen
25
Completing Keywords and Description
26
About the Thesaurus
26
Using the Thesaurus
26
Completing Step 2 of JITI Builder
27
JITI Builder Property Settings for Step 2
27
Toolbar for Step 2
28
Completing Step 2   Summary
28
Completing the Custom Step of JITI Builder
29
Included Schemas
32
Using Controlled Vocabularies with schemas
33
Subject Selector and Controlled Vocabularies
35
HiSoftware Subject Tree Manager
36
Using the HiSoftware Subject Tree Manager
36
Completing Step 3 of JITI Builder
38
Updating the Document Properties
38
Removing properties
38
JITI Builder List Editor
39
JITI Verify
40
JITI Verify Overview
40
Getting started with JITI Verify
42
Example
42
Property Analysis Rule Base
43
Using the Property Analysis Rules Base
44
Properties JITI Verify Can Check
44
HiSoftware metaContents Builder
46
Overview
46
Getting started with metaContents Builder™
46
Index File Tab
48
MetaContents Output Settings
49
HiSoftware metaSearcher
50
HiSoftware metaSearcher Search tab – parts of the screen
50
HiSoftware metaContents Builder
52
Overview
52
Getting started with metaContents Builder™
52
Index File Tab
54
MetaContents Output Settings
55
HiSoftware File List Builder
56
HiSoftware Profile Builder
58



Copyright Information

HiSoftware JITI Builder Office User’s Guide
© 1998-2000 Hiawatha Island Software

This document is provided for informational purposes only. HiSoftware makes no warranties, express or implied.  JITI Builder™ and all supplemental programs and documentation are copyright 1998-2000 HiSoftware.

Microsoft®, Windows®, and Windows NT® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

HiSoftware™, TagGen™, JITI-Verify™, JITI Builder™ metaContents Builder™, metaSearcher™, and Hi-Position™ are trademarks of Hiawatha Island Software Company, Inc. Any and all other product and company names mentioned herein are the trademarks or service marks of their respective owners.  Information in this document is subject to change without notice and does not represent a commitment on the part of Hiawatha Island Software.  The software described in this manual (document) is furnished under license agreement.  The software may be used only in accordance with the terms of this agreement.  It is against the law to copy the software or documentation in any medium except as specifically allowed in the license or nondisclosure agreement.  No part of this manual can be reproduced or retransmitted in any form or by any means, electronically or mechanically, including but not limited to, photocopying, placement on information retrieval systems or any other use not directly related to the purchaser’s personal use.  Expressed written permission from Hiawatha Island Software Company is required prior to reproducing any part of this manual that is outside of the license.

JITI Builder Office User’s Guide, TagGen Business Unit

Initial Publishing: December 25, 2000

Printed in the USA

Part No. JBO 1.0-DOC

Visit our Web Site at http://www.hisoftware.com
Introduction

Thank you for purchasing JITI Builder Office from HiSoftware.


An Introduction to JITI Builder Office

JITI Builder Office edition includes four separate programs:

· JITI Builder

· JITI Verify

· metaSearcher

· metaContents Builder

JITI Builder

JITI Builder is used to add document properties to Microsoft® Word® 2000 and 97, Excel® 2000 and 97, and PowerPoint® 2000 and 97.

JITI Verify

JITI Verify is used to check and verify document properties for Microsoft® Word® 2000 and 97, Excel® 2000 and 97, and PowerPoint® 2000 and 97.

metaSearcher

metaSearcher is a program designed to search for Microsoft® Word® 2000 and 97, Excel® 2000 and 97, and PowerPoint® 2000 and 97 documents on your system based on the file’s document properties metadata.

metaContents Builder

MetaContents Builder is a program designed to create indexes of web files and Office documents, based on metadata.  These indexes can then be placed on the web server for users to search for files based on metadata.

HiSoftware Product Support

Hiawatha Island Software Company is committed to providing the best possible technical support for all of our products.  To get you the fastest and most complete support we ask that you follow these support guidelines.

The HiSoftware web site, http://www.hisoftware.com, is the fastest and most efficient way to find information.  The site contains product information, technical support questions and answers (FAQ’s), maintenance files, and contact information.

The HiSoftware web server is available 24 hours a day 7 days a week 365 days a year.  In addition, the site provides you with many different ways to correspond with us directly.  If you need additional support, please send your questions to support@hisoftware.com.

Registering Your Software

Completion of the HiSoftware product registration form ensures you are eligible for the benefits available to registered users, such as special offers, updates, and exclusive HiSoftware product information.  By registering, you can also access via e-mail our superior technical support staff free for thirty days to help you will any installation issues and for as long as you are using the product.

· You can register via the Internet by visiting http://www.hisoftware.com/register.htm
· You can fill out the registration form included with your product and fax it to Hiawatha Island Software Company at (603) 223-9741.

· Remember - Registering your software lets us know where to send your maintenance releases and other important information. 

Necessary Information for Technical Support
The technical support department at HiSoftware likes to provide detailed and accurate answers to all of your questions.  To do so, our representatives will need the following information:

· Your full name and the name of the registered user, if different,

· Your street address, phone and fax number, and email address,

· The product number of your software,

· The software version number,  (This can be found in the About box, which you can quickly open by running the program and clicking the About selection from the Help menu.)

· The system information of the computer you are using,  (Make and the model of the machine, video driver, operating system, amount of memory and system resources, and any relevant devices you are using.)

· A detailed description of the problem  (Describe any error messages exactly as they appear.  Please list also the steps and conditions that led to the problem.)

For your convenience and to give you the quickest and best technical support, we have included an online technical support request form you can use quickly to organize the information we need.  To access it, go to http://www.hisoftware.com/supreq.htm.  If you cannot access the HiSoftware web site, you can email all of the necessary information previously listed to support@hisoftware.com.

The Best Ways to Contact Technical Support

Because of the amount of information our technical support department needs, and because finding answers may require some research on our part, calling is often the least effective method of getting technical support.  We recommend the following methods as the quickest and best ways to get the answers you need:

1. Product Documentation

Before you spend the time gathering information, contacting HiSoftware, and waiting for a response, make sure that the answer to your question is not in the product documentation.  Take advantage of our help files. 

Check the Readme file for any last-minute information and FAQ's.

2. Internet

Keep informed of all the late breaking information relating to your product by consulting the HiSoftware Web site at http://www.hisoftware.com.  This area is constantly updated with news and notes.  If you have questions about your product, you might save yourself time by checking the HiSoftware web site for the answer.

The product FAQ's contain the answers to many of the commonly asked question that users like you have.  The FAQ's is the site where any new information regarding the use of your product that does not appear in the printed documentation will appear.  The information you need to continue is instantly accessible, 24 hours a day. The FAQ's are located in the technical support area of the HiSoftware web site.

3. Email

Once you have determined that neither the product documentation nor the HiSoftware web site contains the answer you need, the best way to contact the technical support department is through email.  Our address is support@hisoftware.com.

4. Fax

Faxing is the next most efficient means of contacting us.  Our technical support fax number is (603) 223-9741.

Contacting Hiawatha Island Software Company
	Support via Internet or Email


	HiSoftware WWW Site
	http://www.hisoftware.com

	Technical Support via email
	support@hisoftware.com

	Suggestions for future improvements
	http://www.hisoftware.com/register.htm


	Technical Support


	Email
	support@hisoftware.com

	Fax requests for technical support
	(603) 223-9741

	Mail requests for technical support
	HiSoftware

6 Chenell Drive

Concord, NH 03301


	Sales, Marketing and Licensing


	Call either number to order or request information about all HiSoftware products
	Phone     (888) 272-2484

               (603) 229-3055
FAX        (603) 223-9741

Email      info@hisoftware.com
Address: HiSoftware

               6 Chenell Drive

               Concord, NH 03301, USA


Installation

This installation section will walk you through the systematic installation of the HiSoftware JITI Builder Office™.

System Requirements

Please check that the system on which you will be installing the HiSoftware JITI Builder Office™ meets the following requirements:

	Computer
	IBM or Compatible 486 or Higher

(Intel Pentium II or compatible recommended)


	Operating System
	Windows 95, Windows 98 or Windows Millennium, Windows NT 4.0, (Service Pack three or later) or Windows 2000


	RAM
	At least 8 megabytes above the minimum amount required by the operating system.


	Hard Disk Drive
	20 Megabytes for installation




How we Install…

· The HiSoftware JITI Builder Office™ runs a responsible installation on your windows system.  This means that the installation complies with Microsoft standards relating to the addition and removal of files.   

· HiSoftware uses the Windows Installer from Microsoft to install the software.

· HiSoftware will not remove any core system files upon which Windows depends 

· HiSoftware will not remove or update a system file with an older version

· HiSoftware will not remove data created by the program when performing an Uninstall

· HiSoftware will provide an uninstall program via the Control Panel Add/Remove Programs feature.

Directory Structure

The default directory for installation is Program Files\HISC\JITI Builder Office.  For most users, the Program Files folder is located on the C: drive.  The software is installed into this directory and subdirectories of it:

	Directory
	Files

	HISC\JITI Builder Office
	Application files, Help files, readme for JITI Builder

	HISC\JITI Builder Office\data
	Controlled vocabulary files

	HISC\JITI Builder Office\list temp
	Location for temporary files

	HISC\JITI Builder Office\Lists
	Location of stored lists used in Step 2

	HISC\JITI Builder Office\metacontents
	Location of the metaContents program.

	HISC\JITI Builder Office\required
	Location of the schemas for JITI Verify

	HISC\JITI Builder Office \Save
	Location for saved keyword and description files

	HISC\JITI Builder Office \ Schemas
	Location of schemas

	HISC\JITI Builder Office \ Searchprofiles
	Location of profiles for metaSearcher

	HISC\JITI Builder Office \Templates
	Location of templates for metaContents Builder

	HISC\JITI Builder Office \Tips
	Location of tool tip help files


Install Check List

Please make sure that you have checked all items available from the list below before starting your install.

· Installation license code is available (Not required for CD Install)

· If on Windows NT or Windows 2000, Administrator’s rights

· Close all other programs that are running (Highly Recommended)

· Uninstall any previous versions of JITI Builder or JITI Verify™.

Performing Installation for File Downloaded from the Web

1. On the Web, find the web page for downloading the HiSoftware product you selected.  Use the site indicated by your order receipt.  At the site, click the link you require to download the product you are looking for.

2. In the File Download dialog box, click Save this program to disk and save the file on your hard drive.

3. On your hard drive, find the file you downloaded.  Double-click on the application file you downloaded. 
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4. If you are not installing the trial, you will need to enter your password in the next step and then select the Next button.
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5. Click on the Next button in the Welcome window.
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6. You will now be prompted for a destination directory for the installation files (not the actual installation program).  Since these are your installation files, HiSoftware recommends that you back them up just as you would any other important files on your system.

7. Click on the Finish button to accept the default or click on the Browse button to change the directory and then click the Finish Button.   

You are now ready to install the product.

Installation Steps from CD-ROM or Extracted Web File:

1. If installing from a CD-ROM, run the Setup.exe program located on the root of the CD-ROM.  This will start automatically when you insert the CD-ROM into a running computer.

The first step the installation program does is check if the Windows Installer is present on the system.  If the Windows Installer is not present on the system, or if the existing version is older, then the newer version (version 1.1) will be installed on the system.  The Windows Installer is a new program from Microsoft that handles program installation.  It is included as part of Windows 2000, and is offered as an add-in pack for Windows 95/98/NT4.  HiSoftware installs now include the Windows Installer for those users who do not have it.  This installation transparently handles the installation of the Windows Installer in addition to the program.

A small number of users may be prompted for a reboot during installation.  This occurs because the installation program detected an older version of the Windows Installer and is performing an upgrade of that service, or some files the Windows Installer needs were in use at the time.  For those systems requiring a reboot, the HiSoftware product installation will continue after the system reboots.  For more information on the Windows Installer, please visit http://www.hisoftware.com/windowsinstaller.htm
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The above screenshot represents one of the screens visible while the Windows Installer prepares to install.

2. After the Windows Installer has performed its pre-setup tasks, it presents you with the Welcome screen.  Click on the Next button to continue.
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3. The installation presents the license agreement next.
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4. Carefully read the license agreement.  If you accept the terms of the License Agreement, select the I accept the terms in the license agreement option then click Next.  If you do not accept the terms of the License Agreement, select I do not accept the terms in the license agreement option, then click Next to exit the installation program. 

5. Next, the customer information screen is displayed.  Enter your name and organization and select the Next button.
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6. The Setup Type screen then appears.

Either select Default to install the program accepting the default installation path chosen by the Windows Installer or select Custom to modify this path.  
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7. If you selected Custom, the screen below will appear.  The default installation path will be shown in the lower left corner.  To modify the path, select the Change button in the lower right corner.

[image: image10.png]oftware JITI Builder Office - InstallShield Wizard

&
Custom Setup

Select the pragram Features you want nstald.

Click on an con inthe lst below to change how a feature is nstalld.
Feature Deserptin

This Feature instals the main
program files For JITI Bulder
Office.

Softiere JITI Buider OFc

This feature requires 6030KB on
your hard drive.

Instal o
CiProgram Fils|HISC\JIT Bulder Office} Change.

Instalhiel]
Cancel

Help Space <gack





8. The installation is now waiting for user confirmation prior to installing.  Select the Install button to begin installation.
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9. When the installation has completed, select the Finish button.
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Section 2 – JITI Builder Office

Understanding how the program works

PRIVATE ForeHelp xParaStyle ID=1107JITI Builder Office is a collection of four modules designed to improve implementation and use of metadata in your enterprise.  PRIVATE ForeHelp Scaps value=-1Together, these modules allow Microsoft® Office® users to embed metadata, verify metadata and then to search and index documents based on metadata.

· PRIVATE ForeHelp xParaStyle ID=629JITI Builder:  PRIVATE ForeHelp xHotspot ID=16777902JITI BuilderContents_JITI_Builder is used to place metadata in Microsoft® Word®, Excel® and PowerPoint® documents.

· PRIVATE ForeHelp xParaStyle ID=657JITI Verify:  PRIVATE ForeHelp xHotspot ID=16777901JITI VerifyContents_JITI_Verify is used to verify metadata across your computer and shared drives.

· PRIVATE ForeHelp xParaStyle ID=653metaSearcher:  With PRIVATE ForeHelp xHotspot ID=16777900metaSearchermetaSearcher, you can easily search for Office documents based on metadata and file type.

· PRIVATE ForeHelp xParaStyle ID=658metaContents Builder:  PRIVATE ForeHelp xHotspot ID=16777899metaContents BuilderHiSoftware_metaContents_Builder allows you to build html indexes based on metadata.

Launching the program

From the Windows Start menu, select the JITI Builder Office shortcut from the HiSoftware JITI Builder Office program group.


[image: image13.png]J1T1 Builder Office - Explorer

Fie vew tep

~=lolx|

Cavmt | QOmen o Veiy (5 Popeies| M 44 | 5 | 91 @ HISoftware

Locoion [ 234y Dooumerts

=]« Back

Deskion =
ERaY v Cocurer]
() My Fotues
20 My Webs
@ﬁ MySetups.
=8 My Computer
29 3% Floppy ()
52 LocalDik )
21 delphitrain
{21 Documents and Setir
{21 FHSDemo
1 il
=01 ProgianFies
21 Accessories
{21 Botland
{21 Common Files
2] ComPlus Applcali
=0 HsC
£3 Autollpdate
LA i .7

@ 0O 0O 95

MyPictres  MyWebs  MySeups  InstalShield
Software Co.





The program opens to the explorer interface.  This interface is similar to Windows® Explorer®, however the JITI Builder Office explorer interface displays folders and Microsoft® Office documents with the .DOC, .PDF and .XLS extensions only.

PRIVATE ForeHelp xParaStyle ID=3066

PRIVATE ForeHelp Scaps value=0
PRIVATE ForeHelp xParaStyle ID=1110Parts of the main screen

PRIVATE ForeHelp xParaStyle ID=1111There are three main parts of the screen: The menu, the toolbar, and the Explorer® style viewer.

PRIVATE ForeHelp xParaStyle ID=1112
PRIVATE ForeHelp xParaStyle ID=1113The toolbar contains the following buttons:

· PRIVATE ForeHelp xParaStyle ID=3056Default:  The Default button opens the Explorer interface to the default location where your Office documents are stored.  The program installation sets this to the installation directory, but this setting can be changed in program settings to be a path of the user’s choice.  Select the Settings button on the toolbar to change this default path.

· PRIVATE ForeHelp xParaStyle ID=3057Open:  The Open button opens the currently selected files in the user interface in the default viewer for that document type.  You must first select a file, and have the appropriate Office program installed on your system in order for a file to open.

· PRIVATE ForeHelp xParaStyle ID=3058Verify:  The Verify button opens the PRIVATE ForeHelp xHotspot ID=16777898JITI Verify moduleContents_JITI_Verify.  This module is used to verify metadata on one or more Office documents (Word, Excel or PowerPoint).  If one or more programs is selected in the Explorer interface when this button is selected, JITI Verify will open with those files selected.   If no program is selected in the Explorer interface when this button is selected, JITI Verify will open with no file selected.

· PRIVATE ForeHelp xParaStyle ID=3059Properties:  The Properties button opens the PRIVATE ForeHelp xHotspot ID=16777897JITI Builder moduleContents_JITI_Builder.  This module is used to add and remove metadata on one or more Office documents (Word, Excel or PowerPoint).  If one or more programs is selected in the Explorer interface when this button is selected, JITI Builder will open with those files selected.   If no program is selected in the Explorer interface when this button is selected, JITI Builder will open with no file selected.

· PRIVATE ForeHelp xParaStyle ID=3060Index:  The Index button is used to open the PRIVATE ForeHelp xHotspot ID=16777896metaContents Builder moduleHiSoftware_metaContents_Builder.  This module is used to create sorted indexes based on metadata found in Office, web, and XML documents, along with XML packages.

· PRIVATE ForeHelp xParaStyle ID=3061Find Documents:  The Find Documents button opens the PRIVATE ForeHelp xHotspot ID=16777895metaSearchermetaSearcher allowing you to search for Office documents based on metadata.

· PRIVATE ForeHelp xParaStyle ID=3062Settings:  The Settings button allows you to change JITI Builder Office program settings.

· PRIVATE ForeHelp xParaStyle ID=3063Exit:  The Exit button exits the program.

· PRIVATE ForeHelp xParaStyle ID=3064Help:  The Help button opens the program help.

PRIVATE ForeHelp xParaStyle ID=1123
PRIVATE ForeHelp xParaStyle ID=1124The Menu

PRIVATE ForeHelp xParaStyle ID=669The menu contains many of the same commands found on the toolbar, but includes new commands found under the View menu.  These new commands are used to change the icon size in the Explorer view and follow the Microsoft styles used in Windows Explorer.  

PRIVATE ForeHelp xParaStyle ID=196There is also a selection under the View menu titled Toolbar.  This menu option allows you to change the display of the toolbar menu and to show and hide the directory location bar.

PRIVATE ForeHelp xParaStyle ID=3053
PRIVATE ForeHelp xParaStyle ID=3054Explorer Style Interface

PRIVATE ForeHelp xParaStyle ID=3055The Explorer interface is styled after Windows® Explorer®.  It is used to navigate a user’s local and network drives and to locate files and directories.  The JITI Builder Office Explorer will only display Word, Excel and PowerPoint files (DOC, XLS and PPT), along with directories.

Using JITI Builder

To open JITI Builder, select the location of the folder where your document is stored using the tree view on the left side of the Explorer.  Office files of the .DOC, .XLS and .PPT are shown on the right side.  Select one or more documents with the mouse, and then select the Properties button on the explorer toolbar to open JITI Builder.

In the example below, we selected the My Documents folder.  Office files found in this folder are shown in the right pane of the Explorer interface.

If you select the Properties button without first selecting a file, JITI Builder will open, but with no file selected in JITI Builder.

Tip: To select one or more files at a time, hold the CTRL key on the keyboard while selecting files.
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Completing Step 1 of JITI BuilderPRIVATE ForeHelp Scaps value=-1
PRIVATE ForeHelp xParaStyle ID=1902
PRIVATE ForeHelp xParaStyle ID=2310

PRIVATE ForeHelp Scaps value=0

PRIVATE ForeHelp Scaps value=-1

PRIVATE ForeHelp Scaps value=0JITI Builder® Microsoft® Office® 2000 & 97 works with Word® DOC files, Excel® XLS files and PowerPoint® PPT files.
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PRIVATE ForeHelp xParaStyle ID=1904
PRIVATE ForeHelp xParaStyle ID=1905Before you can update files with JITI Builder, you must first select a file or group of files.  In order to properly open, edit and save these Office documents, these documents should not be open in any Office or other application.

PRIVATE ForeHelp xParaStyle ID=1906
PRIVATE ForeHelp xParaStyle ID=1784Selecting One File:
1. PRIVATE ForeHelp xParaStyle ID=1772To select one file, choose Select File from the File menu.

2. PRIVATE ForeHelp xParaStyle ID=1763Browse for a file in the Select File to Load dialog box.

3. PRIVATE ForeHelp xParaStyle ID=1760When located, select the file and click on the Open button.
4. PRIVATE ForeHelp xParaStyle ID=1759If your office document has properties, these properties will be read into the JITI Builder interface.  Note:  Only properties from Excel and Word files will be read in.  JITI Builder cannot read in the properties of PowerPoint files.

PRIVATE ForeHelp xParaStyle ID=1425
PRIVATE ForeHelp xParaStyle ID=1756Selecting Several Files:
1. PRIVATE ForeHelp xParaStyle ID=1740To select several files, choose Select Files from the File menu.

2. PRIVATE ForeHelp xParaStyle ID=1743Browse for files in the Select File(s) to Load dialog box.

3. PRIVATE ForeHelp xParaStyle ID=1731When located, select the files and click on the Open button.
4. PRIVATE ForeHelp xParaStyle ID=1728If your Office documents have properties, these properties will NOT be read into the JITI Builder interface because the read in feature only supports one document at a time.

PRIVATE ForeHelp xParaStyle ID=1747
PRIVATE ForeHelp xParaStyle ID=1640Creating a List of Files:
PRIVATE ForeHelp xParaStyle ID=1641You may also use the File List Builder to create a list of files.  To use the File List Builder, select File List Builder from the Tools menu in the HiSoftware JITI Builder Office program group.   Once you have a file list, you can then select the file list using the Select List menu item.  For more help on the File List Builder, see the File List Builder topic later in this document.

PRIVATE ForeHelp xParaStyle ID=1642
PRIVATE ForeHelp xParaStyle ID=1892PRIVATE ForeHelp xParaStyle ID=1891
PRIVATE ForeHelp xParaStyle ID=1888Parts of the screen

· PRIVATE ForeHelp xParaStyle ID=2835

PRIVATE ForeHelp Scaps value=-1

PRIVATE ForeHelp Scaps value=0Keywords:  These are the specific keywords used to identify your document.  These keywords can then be used by others when searching for information.  Keywords can be entered as words or phrases separated by commas.  The search engines or catalog servers that utilize phrases will take advantage of these words and phrases.  If the search engine does not support phrases, then every item will be taken as a keyword.
· PRIVATE ForeHelp xParaStyle ID=2836Page Description:  This summary information text describes your document.  TIP:  Your description text should include one or more of your keywords.  This is essential for high search engine rankings.

· PRIVATE ForeHelp xParaStyle ID=2320Spell Check:  There is a Spell Check button below the Keywords and Page Description blocks.  These buttons allow you to spell check the Meta tag values to ensure that your information is spelled correctly.  Even though some engines actually try to identify spelling errors you will do best if you make sure that these sections are spelled properly.

· PRIVATE ForeHelp xParaStyle ID=2321Thesaurus:  This button, located next to the Spell Check button, will help look for the right words you need to generate keywords of similar meaning from the words you have entered. 
· PRIVATE ForeHelp xParaStyle ID=2322Load Defaults:  Microsoft Office® stores web site default settings for document properties in every Microsoft Office web.  This button allows you to fill the Keyword and Page Description values from the metadata dictionary.

· PRIVATE ForeHelp xParaStyle ID=2323Write Defaults:  Microsoft Office® stores default document settings for document properties.  This button allows you to write values to the metadata dictionary for the Keyword and Page Description.

· PRIVATE ForeHelp xParaStyle ID=2324Clear All:  Use this button to clear all values that are currently displayed.

· PRIVATE ForeHelp xParaStyle ID=1635Refresh:  This button refreshes the values from the Clear All button action in the wizard on this page and all other pages to the current page in the Microsoft Office Editor.

· PRIVATE ForeHelp xParaStyle ID=1634Next:  Continues to the next tab in the wizard.

· PRIVATE ForeHelp xParaStyle ID=2314Help:  Provides help for all functions on the screen.

· PRIVATE ForeHelp xParaStyle ID=1893About:  Displays the program About box.PRIVATE ForeHelp Scaps value=-1
PRIVATE ForeHelp xParaStyle ID=1843
PRIVATE ForeHelp xParaStyle ID=1840
PRIVATE ForeHelp xParaStyle ID=1839
PRIVATE ForeHelp xParaStyle ID=1836Completing Keywords and Description

1. PRIVATE ForeHelp xParaStyle ID=1889Enter your keywords in the keyword field.  These words should be relative to your subject and exist in the body of your document.  You should enter between 500 to 1000 characters for your keywords. 

2. PRIVATE ForeHelp xParaStyle ID=1858Enter the description of your page in the description field.  The description should be between 150 and 200 characters.  The description should describe your individual page, or if you are updating many pages, your site.

3. PRIVATE ForeHelp xParaStyle ID=1857Click on each of the two spell check buttons to verify the spelling of your keywords and description.

4. PRIVATE ForeHelp xParaStyle ID=1854Should for some reason you need to clear your values and restart, click on the Clear All button.

5. PRIVATE ForeHelp xParaStyle ID=1853When you are ready to move onto the following step, click Next.

PRIVATE ForeHelp xParaStyle ID=1824
PRIVATE ForeHelp xParaStyle ID=1823
PRIVATE ForeHelp xParaStyle ID=1820About the Thesaurus

PRIVATE ForeHelp xParaStyle ID=1819The thesaurus adds a word-building feature that allows you to generate words of similar meaning from the words that you have entered.  Both the keywords and the description sections have their own thesaurus.

PRIVATE ForeHelp xParaStyle ID=1816
PRIVATE ForeHelp xParaStyle ID=1815Using the Thesaurus
1. PRIVATE ForeHelp xParaStyle ID=1850Select the word for which you want to use the thesaurus, and then select the Thesaurus button.  The thesaurus lookup window will then appear.

2. PRIVATE ForeHelp xParaStyle ID=1849In the left side of the thesaurus lookup window will be a sample listing of similar words.  In the right side of the thesaurus will be four tabs.  There is one each for noun, verb, adjective and adverb.

3. PRIVATE ForeHelp xParaStyle ID=1830Double click on a word in the left side of the list to enable the list of words on the right side.

4. PRIVATE ForeHelp xParaStyle ID=1833Navigate though the tabs on the right until you find the word you want to use.  Select that word in the right side list with the mouse.

5. PRIVATE ForeHelp xParaStyle ID=1842Double click on the word in the right side list, than select the Replace button.

Completing Step 2 of JITI Builder
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JITI Builder Property Settings for Step 2

· PRIVATE ForeHelp xParaStyle ID=1214Subject:   This is the subject of your document.  Either type in the subject or select from the default choices given.

· PRIVATE ForeHelp xParaStyle ID=1213Company:   Enter the company of corporation for which this document was written.

· PRIVATE ForeHelp xParaStyle ID=1212Author   Enter the author of the document.

· PRIVATE ForeHelp xParaStyle ID=1211Copyright:   Enter the corporation or group that own the legal copyright to the document.

· PRIVATE ForeHelp xParaStyle ID=1210Language:   Choose the default language of the document from the menu.

· PRIVATE ForeHelp xParaStyle ID=1209Document Number:  Enter the document number here.  Each individual corporation or organization will have its own standard for this field.

· PRIVATE ForeHelp xParaStyle ID=1208Comments:  Enter any comments in this field.

PRIVATE ForeHelp xParaStyle ID=1712
PRIVATE ForeHelp xParaStyle ID=1715Toolbar for Step 2

· PRIVATE ForeHelp xParaStyle ID=1207Load Defaults:  This button allows you to populate the Summary settings from defaults values you had saved earlier.
· PRIVATE ForeHelp xParaStyle ID=1206Write Defaults: This button allows you to write default values for use later in other documents.

· PRIVATE ForeHelp xParaStyle ID=1205Lists:  Lists allows you to PRIVATE ForeHelp xHotspot ID=16777933edit the listsList_Editor used in the drop down fields.

· PRIVATE ForeHelp xParaStyle ID=1204Clear All:  This button clears all values in the Step 2 – Summary tab.

· PRIVATE ForeHelp xParaStyle ID=1203SP- Comments   This button runs the spell check on the Comments field.

· PRIVATE ForeHelp xParaStyle ID=1202Custom   This button tells the JITI Builder wizard to proceed to the Custom Properties tab instead of  the Step 3 Update Document Properties tab.

· PRIVATE ForeHelp xParaStyle ID=1201Next –This button brings the wizard to Step 3 - Update Document Properties.

PRIVATE ForeHelp xParaStyle ID=1226
PRIVATE ForeHelp xParaStyle ID=1223
PRIVATE ForeHelp xParaStyle ID=1222
PRIVATE ForeHelp xParaStyle ID=1221Completing Step 2   Summary
1. PRIVATE ForeHelp xParaStyle ID=1196If you have already saved defaults from a previous document, click on the Load Defaults button. Populate the various fields listed above with your data.
2. PRIVATE ForeHelp xParaStyle ID=1195Click on the SP Comments button to spell check your comments.

3. PRIVATE ForeHelp xParaStyle ID=1194Click on the Write Defaults button if you wish to save the current settings as default for use in future documents.

4. PRIVATE ForeHelp xParaStyle ID=1193Click on the Next button to move to the Update page, or select Custom to go to the Custom Properties Page.

Completing the Custom Step of JITI Builder

PRIVATE ForeHelp xParaStyle ID=1752The Custom/Subject step is used primarily by large Enterprise level organizations with large numbers of documents to catalog and index, either on the Internet or on an intranet.  With this step, you can create, edit, modify, delete, and use custom Meta data schemas. These groupings of meta data allow enterprise level groups to organize collections of documents, provide better search results for their customers, control navigation, and to promote their site.  
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PRIVATE ForeHelp xParaStyle ID=1259
PRIVATE ForeHelp xParaStyle ID=1258Custom Subject TagPRIVATE ForeHelp Scaps value=-1
PRIVATE ForeHelp xParaStyle ID=1250To enter a property value for the Custom Subject tag, enter a value in the field for that property in the edit field.

PRIVATE ForeHelp xParaStyle ID=1249You may also click the Select Subjects button to the right of the field to select a value from a controlled vocabulary.

PRIVATE ForeHelp xParaStyle ID=1248When the PRIVATE ForeHelp xHotspot ID=16778088Select SubjectsSubject_Selector button appears, select a controlled vocabulary list using the top menu and then navigate through the tree view to the value you wish.

PRIVATE ForeHelp xParaStyle ID=1247Double-click on the value and then select the Add button.

PRIVATE ForeHelp xParaStyle ID=1246

PRIVATE ForeHelp xParaStyle ID=1245

PRIVATE ForeHelp xParaStyle ID=1244
PRIVATE ForeHelp xParaStyle ID=1243Some Simple Task Steps:
PRIVATE ForeHelp xParaStyle ID=1242
PRIVATE ForeHelp xParaStyle ID=1844Navigation:

PRIVATE ForeHelp xParaStyle ID=1847Use your ENTER key on the keyboard to traverse through the values and names in the table.  To add additional rows, select the cell located in the last row of the PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1Property Value column.  Once selected, press ENTER on your keyboard to add more rows.  You may also use the + and – buttons to add and delete rows.

PRIVATE ForeHelp xParaStyle ID=1238

PRIVATE ForeHelp xParaStyle ID=1237
PRIVATE ForeHelp xParaStyle ID=1848To create a new Meta data element schema (Set of tags):

1. PRIVATE ForeHelp xParaStyle ID=1864Select the Custom tab.

2. PRIVATE ForeHelp xParaStyle ID=1867Select BASE in the Select Schema menu.

3. PRIVATE ForeHelp xParaStyle ID=1872Add values as required by pressing the ENTER key on your keyboard while the cursor is placed in the last row in the Values column.

4. PRIVATE ForeHelp xParaStyle ID=1880When you have completed your list of Property Names, type over the schema name value in the drop down box and click on the Save button.  The new schema is now selectable in the drop down list.

PRIVATE ForeHelp xParaStyle ID=1230
PRIVATE ForeHelp xParaStyle ID=637The CustomPRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1 tab Toolbar
PRIVATE ForeHelp xParaStyle ID=3028On the bottom of CustomPRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1 toolbar, there are six buttons:
· PRIVATE ForeHelp xParaStyle ID=2828Delete: Selecting this button deletes the current schema

· PRIVATE ForeHelp xParaStyle ID=2845Save: Selecting this button saves the current schema.  This is where you can set default values.  Simply save your entered values by selecting the Save button and the next time you pull up the schema, your defaults will be there.  

· PRIVATE ForeHelp xParaStyle ID=2844Read from Document:  Selecting the Read from Document button reads in any properties used in the document.

· PRIVATE ForeHelp xParaStyle ID=2843Previous:  Select the Previous button to go back to Step 2.

· PRIVATE ForeHelp xParaStyle ID=2842Next:  Select the Next button to continue to Step 3. 

· PRIVATE ForeHelp xParaStyle ID=2841Help:  Selecting the Help button opens the help topic for this step.

PRIVATE ForeHelp xParaStyle ID=3065
PRIVATE ForeHelp xParaStyle ID=1190
PRIVATE ForeHelp xParaStyle ID=1189
PRIVATE ForeHelp xParaStyle ID=1188Using Custom Properties

PRIVATE ForeHelp xParaStyle ID=1187
PRIVATE ForeHelp xParaStyle ID=1186To delete a blank row from a schema

1. PRIVATE ForeHelp xParaStyle ID=1185Clear the name and column values for that row
2. PRIVATE ForeHelp xParaStyle ID=1184Click on the Save button

PRIVATE ForeHelp xParaStyle ID=1183
PRIVATE ForeHelp xParaStyle ID=1907Protecting the Meta Tag name:
PRIVATE ForeHelp xParaStyle ID=1908Select the Protect Name checkbox to make the name field READ ONLY. 

PRIVATE ForeHelp xParaStyle ID=1909
PRIVATE ForeHelp xParaStyle ID=1910Viewing the fields MULTI Line:
PRIVATE ForeHelp xParaStyle ID=1387Selecting the Multi-Line checkbox will dynamically adjust the size of the individual rows.  
PRIVATE ForeHelp xParaStyle ID=1783
PRIVATE ForeHelp xParaStyle ID=1780Auto Sizing Columns

PRIVATE ForeHelp xParaStyle ID=1779Selecting the Auto Size checkbox will dynamically adjust the width of the columns to match the width of the content.  It will also add a horizontal scrollbar if needed.
PRIVATE ForeHelp xParaStyle ID=1776
PRIVATE ForeHelp xParaStyle ID=1426Renaming a schema

1. PRIVATE ForeHelp xParaStyle ID=1427Select the schema you want to rename in the Select Schema menu at the top right corner of the step.
2. PRIVATE ForeHelp xParaStyle ID=1336Type over the existing text in the Select Schema menu, replacing the existing name with the new name.

3. PRIVATE ForeHelp xParaStyle ID=1335Select the Save button in the toolbar at the bottom of the screen.

PRIVATE ForeHelp xParaStyle ID=1646
PRIVATE ForeHelp xParaStyle ID=1645Schema File location

PRIVATE ForeHelp xParaStyle ID=1755Schema files are stored in the schemas subdirectory of the JITI Builder installation.  Typically, this path will be C:\Program Files\HISC\JITI Builder Office\schemas.
Included Schemas

HiSoftware allows the user to either create custom schemas or use some of the predefined schemas.  

The predefined schemas provided are:

· The A-CORE schema is an Australian schema based partly on the Dublin Core schema.

· The AGLS schema is for the Australian Government Locator Service.  The AGLS metadata standard is a set of 19 descriptive elements which government departments and agencies can use to improve the visibility and accessibility of their services and information over the Internet. http://www.naa.gov.au/govserv/agls/
· The Publish schema is a publisher’s style set of Meta elements.

· The Dublin Core element set is a schema intended to be used by non-catalogers as well as resource description specialist.  Visit the Dublin Core web site for more info. http://www.purl.org/dc. This is a strip down version of the Pure Dublin Core tags that can be written with the Dublin Core Editor.

· The Base schema is where a user can create a custom schema.

· GILS is Global Information Locator Service.  JITI Builder offers custom Meta properties meeting requirements for GILS.  For more information, visit http://www.gils.net/
· The IMS schema is also supported.  Please see the IMS Project website for more information on this project and how its members are trying to define learning on the Internet. http://www.imsproject.org/index.html
· The MS Extended schema is a schema from Microsoft Corporation.

· The WAGILS schema uses enhanced Meta data attributes to identify documents and is used by Washington State Government Information Locator Service.  Additional information may be found at the Washington State Library. http://www.statelib.wa.gov/info_rscrs/dbs_tools/find-it/gils.htm
Using Controlled Vocabularies with schemas

For users that want to use controlled vocabularies in the form of a list in their schemas, JITI Builder Office includes a Custom Field Editor.  With the Custom Field Editor, you can create drop-down menus and calendar date choosers for your schemas.

For example, you have a schema named Sales.  In this schema, you have several meta names, including Sales Region and Date of Contact.  You want to enforce that users entering meta data with this scheme choose from a valid sales region and you want to make it convenient to choose a date.

1. From the Special menu of JITI Builder, select Custom Field Editor.  The Custom Field Editor now opens.  

2. Select New from the File menu of the Custom Field Editor.  

3. In the Name field, enter the names of your meta tags.  For our example here, we will enter Sales Region on one row and Date of Contact on the other.   Your meta tags names will be different, depending on the meta tags you have in your custom schema.
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4. In the Type column, we choose Drop Down in the Sales Region row and Date in the Date of Contact row.

5. In the Edit column of any row where drop-down is selected, click in the Edit field with the left mouse button.  The Custom Field Data Editor appears.

6. In this window, enter all the possible values for your meta tag names.  In our example for the Sales Region meta tag, we will enter North, South, East and West.  When done in this window, click on the Save button.  This button looks like a floppy disk.  Then, close the Custom Field Data Editor window.
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7. In the Custom Field Editor, save your file by selecting the Save As from the File menu.  Make sure you save the file to the schemas directory and include the .sbf file extension.  In our example, we named the file Sales.sbf because we wanted to use this file with the Sales schema that we created.  NOTE:  The files names for this feature are case sensitive.  If your schema is named Sales, then you must name files created with the custom field editor with the same case as the schema.  In our example, we need to save as Sales, and not SALES or sales.

8. Close the Custom Field Editor.

9. In the Custom tab of JITI Builder, select your custom schema.  We are using the Sales Schema.

10. For those properties that you had selected as drop-down menus, the drop-down menus will appear in the cells when the cell is clicked in with the mouse.  For those properties where Date was selected when in the Custom Field Editor, a calendar control will appear when the mouse is clicked in that cell.
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Subject Selector and Controlled Vocabularies

The Subject Selector is used when creating Controlled Vocabularies.  These are found in the Custom Step:
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To use:

1. Select a vocabulary in the drop-down menu.  These vocabularies are created with the HiSoftware Subject Tree Manager.  Navigate through the tree to a meta tag value that you want to use.  

2. Double click on an item in the tree to add it to the selection field at the top of the Subject Selector.

3. Select the Add button to add this value to the value for the Custom Subject Tag.

4. When done, select the Exit button to exit.

5. The Replace button and Close button are also available during selection.

HiSoftware Subject Tree Manager

The HiSoftware Subject Tree Manager is a utility for easily creating the tree files (.HSTF) used with controlled vocabularies.  This feature will mostly be used by Enterprise level organizations employing controlled vocabularies.
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Using the HiSoftware Subject Tree Manager

An easy way to understand this program is to select Open from the File menu and select the default.hstf file provided.  This file contains a schema populated with a large number of Meta tag values in a tree format.

· To create your own file, select New from the File menu.  Enter a branch for the tree in the tree view control. 

· To add more branches, select the Item button on the toolbar and add more items.

· To add sub-items, select the item or branch were you want to add the item and then select the Sub Item button.

· To delete an item or sub-item, select the item and then select the Delete button.

· To rename an item, select the item and the click the Rename button.  The program will highlight the text to be renamed.  Enter in the new text and then select the ENTER key to accept changes.

· When done, select the Save or Save As keys to save your files.  These files are stored by default to the lists subdirectory of the JITI Builder Office installation.  These lists can later be shared with other members of your enterprise.

Completing Step 3 of JITI Builder
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PRIVATE ForeHelp xParaStyle ID=2212
PRIVATE ForeHelp xParaStyle ID=2211Updating the Document Properties
1. PRIVATE ForeHelp xParaStyle ID=2191To view the properties JITI Builder will update prior to the update, click on the Show button.

2. PRIVATE ForeHelp xParaStyle ID=2196Confirm that none of the documents you are updating is currently open by a Microsoft Office application.  Documents open by Office programs will be locked for editing and JITI Builder cannot update them

3. PRIVATE ForeHelp xParaStyle ID=2197When you are ready to update the file(s), click on the Update button.  As the files update, a progress bar will show the status of the update.
4. PRIVATE ForeHelp xParaStyle ID=2198Click on the Exit button to exit the program.

PRIVATE ForeHelp xParaStyle ID=2206

PRIVATE ForeHelp xParaStyle ID=2204
PRIVATE ForeHelp xParaStyle ID=2203Removing properties
PRIVATE ForeHelp xParaStyle ID=2202If you wish to remove properties, enter the text REMOVE in any of the fields and select the Remove Properties marked Remove checkbox in Step 3.  When the Remove Properties marked “Remove” checkbox is selected, no properties are added during the update and properties with the REMOVE text are removed from the document.
PRIVATE ForeHelp xParaStyle ID=2201
PRIVATE ForeHelp xParaStyle ID=2200The Help button provides help for this screen.PRIVATE ForeHelp Scaps value=-1
JITI Builder List Editor

The List Editor is a simple text editor used to edit the lists for the tags in Step 2.  To start the List Editor, select Lookup List Editor from the Special menu in JITI Builder

At the top of the List Editor is a toolbar with buttons to represent the command of Cut, Copy, Paste, Save, Exit and Help.
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Using the List Editor

1. Select the list you want to edit by selecting it in the drop-down menu on the left.

2. Enter one value per line

3. Leaving a blank space at the top of the list allows for a null selection option.

4. Use the Cut, Copy and Paste buttons as needed.

5. When done, select the Save button, then the Exit button.

JITI Verify

JITI Verify Overview

PRIVATE ForeHelp xParaStyle ID=2279

PRIVATE ForeHelp Scaps value=0
PRIVATE ForeHelp xParaStyle ID=1284

PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1

PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Scaps value=0Creating searchable indexes of documents can be simplified by placing meta properties in the documents.  A search engine or web crawler can then identify these properties and use them for indexing.  This creates a much more accurate index, since the index is not based on a full text search, but is based on keywords and other properties identified by the author.  Part of developing a Meta property strategy is locating the documents that need Meta properties.  JITI Verify searches files located locally and on network drives and runs verification on them, letting you know which files need updating.

PRIVATE ForeHelp xParaStyle ID=2089
Note: PRIVATE ForeHelp xParaStyle ID=2088There is no limit to the number of files that can be checked at once.

PRIVATE ForeHelp xParaStyle ID=2087
PRIVATE ForeHelp xParaStyle ID=2086The verification of Meta properties allows you to:
1. PRIVATE ForeHelp xParaStyle ID=2082Verify that your document authors are using the document properties that you have set as a standard.

2. PRIVATE ForeHelp xParaStyle ID=2081Verify that the properties used match your enterprise policy.
3. PRIVATE ForeHelp xParaStyle ID=2079Verify basic document promotion settings.
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JITI Verify Main Window

PRIVATE ForeHelp xParaStyle ID=2090

PRIVATE ForeHelp Scaps value=0

PRIVATE ForeHelp Scaps value=-1The main screen of JITI Verify has four main sections.

PRIVATE ForeHelp xParaStyle ID=2085
PRIVATE ForeHelp xParaStyle ID=2284The Main Menu
PRIVATE ForeHelp xParaStyle ID=2285Provides access to all commands available via the user interface via a menu system that does not require the usage of the mouse.

PRIVATE ForeHelp xParaStyle ID=2286
PRIVATE ForeHelp xParaStyle ID=2287The Button Toolbar
PRIVATE ForeHelp xParaStyle ID=2288This toolbar located below the main menu contains buttons that execute commands when pressed.PRIVATE ForeHelp xParaStyle ID=2289
PRIVATE ForeHelp xParaStyle ID=2290
· PRIVATE ForeHelp xParaStyle ID=2048Verify - Allows the user to run the actual property analysis report based on settings in the PRIVATE ForeHelp xHotspot ID=16777945Analysis Rule BaseSetting_up_Values_in_the_Rule_Base.  The user needs to select files from a map-able drive on their computer.  Multiple files can be selected.PRIVATE ForeHelp xParaStyle ID=2046
· PRIVATE ForeHelp xParaStyle ID=2045Open - Opens a saved results setPRIVATE ForeHelp xParaStyle ID=2044
· PRIVATE ForeHelp xParaStyle ID=2043Save - Saves the verification results to a results setPRIVATE ForeHelp xParaStyle ID=2042
· PRIVATE ForeHelp xParaStyle ID=2041Send - Allows the user to e-mail the results setPRIVATE ForeHelp xParaStyle ID=2040
· PRIVATE ForeHelp xParaStyle ID=2039Print - Allows the user to print the results set

· Settings - Allows the user to setup the current printer for the purpose of printing the report

· Copy - Copies the selected text

· Clear - Allows the user to clear the results window where the property analysis report is shown

· Rules - Allows the user to edit the property analysis rules that are used to generate the report.  More info: Setting up Values in the Rule Base.  In the rule base, you can also select items that are to be verified as required.

· Exit - Closes the JITI Verify program

· Help - Allows the user to access the help system

PRIVATE ForeHelp xParaStyle ID=1624
PRIVATE ForeHelp xParaStyle ID=1616Files that passed the Policy Check
PRIVATE ForeHelp xParaStyle ID=1137This section, directly below the toolbar, shows the property analysis report for files that passed the analysis verification.

PRIVATE ForeHelp xParaStyle ID=2713
PRIVATE ForeHelp xParaStyle ID=1136Files that failed the Policy Check
PRIVATE ForeHelp xParaStyle ID=1596This section, directly below the passed files area, shows the property analysis report for files that failed the analysis verification.

Getting started with JITI Verify
PRIVATE ForeHelp xParaStyle ID=1980

PRIVATE ForeHelp Scaps value=0

PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1

PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Scaps value=0
PRIVATE ForeHelp xParaStyle ID=1981JITI Verify is easy to use and has three main steps.

1. PRIVATE ForeHelp xParaStyle ID=2010The first step is to PRIVATE ForeHelp xHotspot ID=16777804choose an existing, or to create a new schemaSetting_up_Values_in_the_Rule_Base to compare your documents.

2. PRIVATE ForeHelp xParaStyle ID=2009The second step is to assemble a list of files to check.  This can be done by selecting them individually or by first creating a file list and then selecting the file list.

3. PRIVATE ForeHelp xParaStyle ID=2004The third step is to run the analysis and view your results.

PRIVATE ForeHelp xParaStyle ID=2561
PRIVATE ForeHelp xParaStyle ID=2560
PRIVATE ForeHelp xParaStyle ID=2559Example
1. PRIVATE ForeHelp xParaStyle ID=2007From the JITI Verify main window, select the Rules button on the toolbar.  The Property Analysis window opens.

2. PRIVATE ForeHelp xParaStyle ID=2751Using the drop-down style menu at the top right corner of this window, select BASE from the menu.

3. PRIVATE ForeHelp xParaStyle ID=2752In the table, replace the word base in the left property name column with Author.  In the Property Value column beside author, enter your name.  For this example, we are using the name John Smith as our author.

4. PRIVATE ForeHelp xParaStyle ID=2749Save the schema by selecting the Save button at the lower left corner.

5. PRIVATE ForeHelp xParaStyle ID=2779Next, click on the close button at the lower right corner.

6. PRIVATE ForeHelp xParaStyle ID=2778Back in the main screen of JITI Verify, select the Verify button on the toolbar.

7. PRIVATE ForeHelp xParaStyle ID=2777In the file selection toolbar, navigate to a file created in Word, Excel or PowerPoint.  (Versions 97 or 2000).  Select the file and click on the Open button.  The analysis now runs.

8. PRIVATE ForeHelp xParaStyle ID=2774If the document you selected had the author name you selected, the analysis will report this file as passing.  If the file you chose did not have the author property equal to what you entered in the Property Analysis Rules Base, the analysis will report the file as failing and will give you the current property value and what the value should be.

PRIVATE ForeHelp xParaStyle ID=2550
PRIVATE ForeHelp xParaStyle ID=2012Back in the Rules Base, if you entered a Property Name as Author, but did not enter a Property Value, the Analysis will check just to make sure the property name in your document is populated with a value, but will not check to see what the value is.

Property Analysis Rule Base

PRIVATE ForeHelp xParaStyle ID=1982

PRIVATE ForeHelp Scaps value=0

PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1The Property Analysis Rules Base is the most important screen in the program.  When JITI Verify runs, it uses the settings in this screen to perform its analysis on the currently selected schema.  JITI Verify works best on files whose properties have been modified with JITI Builder.
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PRIVATE ForeHelp xParaStyle ID=2162
PRIVATE ForeHelp xParaStyle ID=2163
PRIVATE ForeHelp xParaStyle ID=2164Parts of the screenPRIVATE ForeHelp xParaStyle ID=2165
· PRIVATE ForeHelp xParaStyle ID=2166Auto Size: Selecting this checkbox automatically adjusts the column width to accommodate the entered names and values.

· PRIVATE ForeHelp xParaStyle ID=2167Multi-Line:  Selecting this checkbox modifies the view so that information that is too large to be viewed in one table cell can be viewed in two or more lines.
· PRIVATE ForeHelp xParaStyle ID=2168Protect Name:  Selecting the Protect Name checkbox applies a read-only filter to the Property Name column so these values cannot accidentally be over-written.

· PRIVATE ForeHelp xParaStyle ID=2169Schema name:  This is the drop down style menu at the top right of this window.  Use this menu to select different schemas, or type into this menu to rename them.

· PRIVATE ForeHelp xParaStyle ID=2170Required Properties:  This table lists the Property Names and Property Values that JITI Verify will check and confirm

· PRIVATE ForeHelp xParaStyle ID=2171Save:  The save button saves the presently displayed schema.  It will save any modifications you made to the Property Names or Property Values.  If you renamed the schema by typing over the name with a new name, save will save that schema as the new name and it will now be available from the menu.

· PRIVATE ForeHelp xParaStyle ID=2172Delete:  This button will delete the presently displayed schema.  HiSoftware recommends you use this button with care and not delete any of the default schemas that come with the software, just custom schemas created by the user.

· PRIVATE ForeHelp xParaStyle ID=2173Help:   Provides help for this screen

· PRIVATE ForeHelp xParaStyle ID=2174Close: Closes the Property Analysis Rule Base window.

PRIVATE ForeHelp xParaStyle ID=2175
PRIVATE ForeHelp xParaStyle ID=2176
PRIVATE ForeHelp xParaStyle ID=2177
PRIVATE ForeHelp xParaStyle ID=2178Using the Property Analysis Rules Base

PRIVATE ForeHelp xParaStyle ID=2179
PRIVATE ForeHelp xParaStyle ID=2180Using the Property Analysis Rules Base is quiet simple.

1. PRIVATE ForeHelp xParaStyle ID=2181In the menu at the top right corner, select a schema.  For this example, select MS Extended.  The table is now populated with the MS-Extended schema.
2. PRIVATE ForeHelp xParaStyle ID=2182The MS-Extended schema contains twenty-five Property Names.  If you were to run the analysis with all twenty-five properties, the analysis would check each file and confirm that each of the twenty-five properties lists had a value.
3. PRIVATE ForeHelp xParaStyle ID=2189If you enter a value in the row corresponding to a name, the analysis will check to make sure that the documents being checked have the property listed with the value selected.  For example, if we had the value “John Smith” beside the “Checked By” Property Name, when the analysis runs, every document will be checked to make sure that the property named “Checked By” exists and that its value is ”John Smith”.

PRIVATE ForeHelp xParaStyle ID=2183
PRIVATE ForeHelp xParaStyle ID=2184If you wish not to check for all properties in a schema, but only wanted to check five of the properties, for example, you can modify the schema not to check for them.

1. PRIVATE ForeHelp xParaStyle ID=2185Select the schema you want to start with.

2. PRIVATE ForeHelp xParaStyle ID=2186In the schema menu at the top right corner of the screen, select the existing schema name with the mouse and delete it.  Then, enter a new name for this schema and click on the Save button at the bottom left corner of the window.  The original schema will be saved with a new name.

3. PRIVATE ForeHelp xParaStyle ID=2187From there, the user can select individual property names and delete the contents of the property names and or values, add new properties or values and then save the schema again by selecting the Save button.PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1
Properties JITI Verify Can Check

PRIVATE ForeHelp xParaStyle ID=2249

PRIVATE ForeHelp Scaps value=0

PRIVATE ForeHelp Scaps value=-1

PRIVATE ForeHelp Scaps value=0
PRIVATE ForeHelp xParaStyle ID=2053JITI Verify comes with several default schemas in the Property Analysis Rules Base.  Additionally, you can modify any of the schemas, then rename and save it to create a new schema.  These schemas are copies of the schemas used in JITI Builder.  While the schemas used in JITI Builder are stored in the schemas subfolder of the JITI Builder Office subfolder, the schemas used by JITI Verify are stored in the required subdirectory of the JITI Builder Office installation

PRIVATE ForeHelp xParaStyle ID=2250
PRIVATE ForeHelp xParaStyle ID=2252
PRIVATE ForeHelp xParaStyle ID=2253The default schemas provided are:
· PRIVATE ForeHelp xParaStyle ID=2502The A-CORE schema is an Australian schema based partly on the Dublin Core schema.
· PRIVATE ForeHelp xParaStyle ID=2501The AGLS schema is for the Australian Government Locator Service.  The AGLS metadata standard is a set of 19 descriptive elements which government departments and agencies can use to improve the visibility and accessibility of their services and information over the Internet.

· PRIVATE ForeHelp xParaStyle ID=2500The Publish schema is a publisher’s style set of Meta elements.

· PRIVATE ForeHelp xParaStyle ID=2499The Dublin Core element set is a schema intended to be used by non-catalogers as well as resource description specialist.

· PRIVATE ForeHelp xParaStyle ID=2456The Base schema is where a user can create a custom schema.

· PRIVATE ForeHelp xParaStyle ID=2455GILS is Global Information Locator Service.  PRIVATE ForeHelp Scaps value=-1JITI Builder Office offers custom Meta properties meeting requirements for GILS.  For more information, visit www.gils.net

· PRIVATE ForeHelp xParaStyle ID=2454The GILSMask schema allows for language independent Meta tags.

· PRIVATE ForeHelp xParaStyle ID=2453The IMS schemas is also supported.  Please see the IMS Project website for more information on this project and how its members are trying to define learning on the Internet.

· PRIVATE ForeHelp xParaStyle ID=2452The MS Basic schema is the default schema found in Microsoft Office 2000.

· PRIVATE ForeHelp xParaStyle ID=2451The MS Extended schema is a schema from Microsoft Corporation.

· PRIVATE ForeHelp xParaStyle ID=2450The WAGIL schema uses enhanced Meta data attributes to identify documents.  Used by Washington State Government Information Locator Service.  Additional information may be found at the Washington State Library.

HiSoftware metaContents Builder

Overview

The HiSoftware metaContents Builder™ creates indexes of files based on metadata.  This program works for files located locally on the system or available via networked drives.  Once an index has been created, it can then use placed on a web server or file server so that others can have access to the HTML based index, complete with hyperlinks to those indexed files.
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Getting started with metaContents Builder™

1. From the Windows Start menu, select the HiSoftware JITI Builder Office program group.  Next, select the JITI Builder Office shortcut.  The program now opens to the explorer interface.  Select the Index button on the explorer interface to open metaContents Builder.  The Index Configuration tab is now selected in the program. 

2. In the Index Configuration tab, valid index-able file types appear for the web you have selected.  The File-Type menu has several choices populated by default.  These choices include web documents and web packages.  Web Packages are documents wrapped in metadata using the metaPackager program from HiSoftware. If you wish to add additional documents to the Web Documents filter, select Edit Web Document File Extensions from the Settings menu of metaContents Builder.  Note: files selected need to have metadata in them in order for the program to work correctly.

3. The Located In field is where the program will start to looking for files to index.  Select the File Chooser button to the right of this field to open up an explorer window where you can select drives and folders.

4. Select the Include Subfolders checkbox to instruct metaContents Builder to include the subfolders when indexing the location selected in the Located In field.

5. The Use drive and path in index checkbox codes in the absolute file path to the documents listed.  For example C:\Program Files\HISC\metaindex.html.  There are both advantages and disadvantages to selecting this checkbox.  If you select this checkbox, you can then rename and move the index file created anywhere on the system and the index will work.  The disadvantage is that if you want to copy the whole indexed directory with the index file to a web server, unless the directory structure on the web server is exactly the same, which it most likely will not be, the index file will not work because the drive letters and directories were hard coded in.  If you do not select the Use drive and path in index checkbox, the index file created will have relative paths to the files and subdirectories below it, but no reference to the file structure above it.   As long as the index file is kept in its relative location to the other files, the index will work no matter where the index and relative files are located.  This is the recommended option when the intent of the index is to place it on a web server.  The Description Tag will be used to describe the document in the index.  The Description Tag is set to use the description metatag by default, but others tags can be selected instead.  The recommended choice for this selection is the description tag.

6. The Classification Tag will be used to organize the documents in categories in the index.  Choose a selection from the drop-down menu.

7. In the Additional Tags to Display menu, you can check additional meta tags to display in the index.  You can use the Select All and Clear All buttons to the right of the list to speed up the selection process.

8. To add additional tags to the list, use the Edit Profile button to  open up a window where additional tags can be added to the profile.

9. When you are ready to create the list of files in your selected drive or folder, click on the Build HTML button.  MetaContents Builder will then create a list of files that met the Files of Type criteria and will then open to the Index Files tab.

MetaContents Builder toolbar

· Save Profile:  The Save Profile button saves the settings in Step 1 – Index Configuration.  This includes the Description Tag, the Classification Tag and the Additional Tags to Display.

· Edit Profile:  Selecting the Edit Profile button opens a window where you can add, modify or remove meta tags in the profile list.  To add a row, click on the last row and select Enter.

· Stop:  Selecting the Stop button stops the action of indexing files on your system.

· Build List:  Selecting the Build List button builds the list of files to index and then opens the Index Files tab of metaContents Builder.

· Help:  Selecting the Help button opens the program help.

Index File Tab
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1. The Index File tab displays all files found and is organized by category.  If the tag selected for classification could not be located in the document, the document will be located in a folder named Unknown.

2. In the tree view, select the files that you want to index.  By default, all files for the selected folders are checked.  To prepare a file to be indexed, make sure it has a check in the checkbox beside it.  To remove a file from the list of files to be indexed, remove any check that may be present from the checkbox beside it.

3. When you are ready to build the index file, select the Build HTML button.  The index file will be build according to the name selected in the Output Settings found under the Settings menu.  The index file will either be stored in the root o the directory you indexed, or in a subdirectory of that directory if you selected that option in the settings.  For more help on this, please see the help topic for output settings.

4. From here, you can take the index file you created and place it into your web so web users can have indexes based on metadata, or on a file server where users have shared access to data.

Edit Profile Tag Names
· To add an additional meta tag to the list, select the Add button.

· To delete a meta tag from the listing, click on the tag in the list and then select the Delete button.

· To close without saving changes, select the Cancel button.

· To close saving the changes, select the Update button.

MetaContents Output Settings

metaContents Builder allows you control of the output of the indexes.

Number of Columns:  Using this option, you can select the number of columns for the report.  

Index filename:  Enter the name for the index file in this field.  The default name is metaindex.  The program automatically appends the html file extension to the file name.  The index files are stored in the root of  the drive and path selected in the Located In field.   C:\My Documents\My Webs\metaindex.html.

Generate Index Files:  The program gives the option to create separate index files for each category, or create an index file with separate sections for each category.  If the multiple index file option is selected, each index file will be placed in a subdirectory of the ndx_temp folder named meta_ndx.  The index files will be created in that folder named after the categories listed.

Sub Directory Name:  This field is used to select the name of the folder where the index files are stored.  This folder will be located under the root of the Located In field selected in the Index Configuration tab.  The subdirectory feature only works when generating multiple index files

Changing the Output Settings

Modify any of the settings and select the OK button.  Once the program restarts, the new settings will be used.

HiSoftware metaSearcher

The HiSoftware metaSearcher allows for fielded searching of metadata in PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1Microsoft Office Files.

To start metaSearcher, select the Search Documents item from the File menu in JITI Builder Office explorer interface, or select the Find Documents icon in the toolbar or the JITI Builder Office explorer interface
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PRIVATE ForeHelp xParaStyle ID=587
PRIVATE ForeHelp xParaStyle ID=588HiSoftware metaSearcher Search tab – parts of the screen

· PRIVATE ForeHelp xParaStyle ID=589Files of Type: In this menu, select the type of file to search for.  This includes PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1DOC, XLS and PPT files.

· PRIVATE ForeHelp xParaStyle ID=590Located in: Enter the path in which to search for these files.

· PRIVATE ForeHelp xParaStyle ID=591Search Profile:  You can select a search profile created with the HiSoftware Profile Builder.  The Profile Builder is located in the Windows Start menu under the HiSoftware PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1JITI Builder Office programs group in the Tools subfolder.

· PRIVATE ForeHelp xParaStyle ID=592Property Name:  In the property name field, enter the name of the meta property you are searching for.  For example, enter keywords or description.

· PRIVATE ForeHelp xParaStyle ID=593Property Value:  Enter the value for the search property in the table.

· PRIVATE ForeHelp xParaStyle ID=594Include subfolders:  Include subfolders in the search

· PRIVATE ForeHelp xParaStyle ID=595Exact matches only:  Selecting this checkbox limits the search to exact matches only.

PRIVATE ForeHelp xParaStyle ID=596  

PRIVATE ForeHelp xParaStyle ID=597HiSoftware metaSearcher toolbar
· PRIVATE ForeHelp xParaStyle ID=598Help:  Provides help for this screen
· PRIVATE ForeHelp xParaStyle ID=599Save:  Saves the results

· PRIVATE ForeHelp xParaStyle ID=600New Search: Clears the current search and prepares for a new search

· PRIVATE ForeHelp xParaStyle ID=601Stop:  Stops a search in progress

· PRIVATE ForeHelp xParaStyle ID=602Find Now:  Starts the search

PRIVATE ForeHelp xParaStyle ID=603
PRIVATE ForeHelp xParaStyle ID=604HiSoftware metaSearcher Files Found tab – parts of the screen
· PRIVATE ForeHelp xParaStyle ID=607Open:  Selecting the Open button opens the PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1Office file.   If you have PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1Microsoft Word, Excel or PowerPoint on your system, you can open the PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1Office file though metaSearcher.  

· Verify:  Selecting Verify opens the document in the JITI-Verify module

· Properties:  Selecting Properties opens the document in the JITI Builder module.PRIVATE ForeHelp Underline value=0

PRIVATE ForeHelp Blink value=0

PRIVATE ForeHelp Scaps value=-1
HiSoftware metaContents Builder

Overview

The HiSoftware metaContents Builder™ creates indexes of files based on metadata.  This program works for files located locally on the system or available via networked drives.  Once an index has been created, it can then be placed on a web server or file server so that others can have access to the HTML based index, complete with hyperlinks to those indexed files.
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Getting started with metaContents Builder™

1. From the Windows Start menu, select the HiSoftware JITI Builder Office program group. Next, select the JITI Builder Office shortcut. The program now opens. Next select the Index button on the toolbar. The Index Configuration tab is now selected in the program.

2. In the Index Configuration tab, valid index-able file types appear for the web you have selected.  The File-Type menu has several choices populated by default.  These choices include web documents and web packages.  Web Packages are documents wrapped in metadata using the metaPackager program from HiSoftware. If you wish to add additional documents to the Web Documents filter, select Edit Web Document File Extensions from the Settings menu of metaContents Builder.  Note: files selected need to have metadata in them in order for the program to work correctly.

3. The Located In field is where the program will start to looking for files to index.  Select the File Chooser button to the right of this field to open up an explorer window where you can select drives and folders.

4. Select the Include Subfolders checkbox to instruct metaContents Builder to include the subfolders when indexing the location selected in the Located In field.

5. The Use drive and path in index checkbox codes in the absolute file path to the documents listed.  For example C:\Program Files\HISC\metaindex.html There are both advantages and disadvantages to selecting this checkbox.  If you select this checkbox, you can then rename and move the index file created anywhere on the system and the index will work.  The disadvantage is that if you want to copy the whole indexed directory with the index file to a web server, unless the directory structure on the web server is exactly the same, which it most likely will not be, the index file will not work because the drive letters and directories were hard coded in.  If you do not select the Use drive and path in index checkbox, the index file created will have relative paths to the files and subdirectories below it, but no reference to the file structure above it.   As long as the index file is kept in its relative location to the other files, the index will work no matter where the index and relative files are located.  This is the recommended option when the intent of the index is to place it on a web server.  Note:  The Use drive and path in index option creates hyperlinks that work correctly with Microsoft(r) Internet Explorer(r), but are incompatible with Netscape(r) Navigator(r).

6. The Description Tag will be used to describe the document in the index.  The Description Tag is set to use the description metatag by default, but others tags can be selected instead.  The recommended choice for this selection is the description tag.

7. The Classification Tag will be used to organize the documents in categories in the index.  Choose a selection from the drop-down menu.

8. In the Additional Tags to Display menu, you can check additional meta tags to display in the index.  You can use the Select All and Clear All buttons to the right of the list to speed up the selection process.

9. To add additional tags to the list, use the Edit Profile button open up a window where additional tags can be added to the profile.

10. When you are ready to create the list of files in your selected drive or folder, click on the Build HTML button.  MetaContents Builder will then create a list of files that met the Files of Type criteria and will then open to the Index Files tab.

MetaContents Builder toolbar

· Save Profile:  The Save Profile button saves the settings in Step 1 – Index Configuration.  This includes the Description Tag, the Classification Tag and the Additional Tags to Display.

· Edit Profile:  Selecting the Edit Profile button opens a window where you can add, modify or remove meta tags in the profile list.  To add a row, click on the 

· Stop:  Selecting the Stop button stops the action of indexing files on your system.

· Build List:  Selecting the Build List button builds the list of files to index and then opens the Index Files tab of metaContents Builder.

· Help:  Selecting the Help button opens the program help.

Index File Tab
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1. The Index File tab displays all files found and is organized by category.  If the tag selected for classification could not be located in the document, the document will be located in a folder named Unknown.

2. In the tree view, select the files that you want to index.  By default, all files for the selected folders are checked.  To prepare a file to be indexed, make sure it has a check in the checkbox beside it.  To remove a file from the list of files to be indexed, remove any check that may be present from the checkbox beside it.

3. When you are ready to build the index file, select the Build HTML button.  The index file will be build according to the name selected in the Output Settings found under the Settings menu.  The index file will either be stored in the root for the directory you indexed, or in a subdirectory of that directory if you selected that option in the settings.  For more help on this, please see the help topic for output settings.

4. From here, you can take the index file you created and place it into your web so web users can have indexes based on metadata, or on a file server where users have shared access to data.

Edit Profile Tag Names
· To add an additional meta tag to the list, select the Add button.

· To delete a meta tag from the listing, click on the tag in the list and then select the Delete button.

· To close without saving changes, select the Cancel button.

· To close saving the changes, select the Update button.

MetaContents Output Settings

metaContents Builder allows you control of the output of the indexes.

Number of Columns:  Using this option, you can select the number of columns for the report.  

Index filename:  Enter the name for the index file in this field.  The default name is metaindex.  The program automatically appends the html file extension to the file name.  The index files are stored in the root of drive and path selected in the Located In field.   C:\My Documents\My Webs\metaindex.html.

Generate Index Files:  The program gives the option to create separate index files for each category, or create on index file with separate sections for each category.  If the multiple index file option is selected, each index file will be placed in a subdirectory of the ndx_temp folder named meta_ndx.  The index files will be created in that folder named after the categories listed.

Sub Directory Name:  This field is used to select the name of the folder where the index files are stored.  This folder will be located under the root of the Located In field selected in the Index Configuration tab.  The subdirectory feature only works when generating multiple index files

Changing the Output Settings

Modify any of the settings and select the OK button.  Once the program restarts, the new settings will be used.

HiSoftware File List Builder

The File List Builder allows the user to create a list of files for use when updating many files, including ones from separate folder.

To start the File List Builder, select the File List Builder shortcut found in the Tools subfolder of the HiSoftware JITI Builder Office program group in the Windows start menu.

Setup of the File List Builder

It may be necessary to edit the file extensions you will be using.  The file list builder can filter showing only certain file extensions, or it can show all files when no files extensions are selected.  Adding these extensions to the File List Builder program is easy.

1. From the Edit menu, select Include List, or select the Include button from the toolbar.

2. Enter your file extensions without the preceding period into the field above the Enter The Extension text.  When complete, click on the  + Add button. 

3. Items can be deleted from the extension list by using the - Delete button.

4. Removing all extensions from the extension list removes all filtering and shows every file and subdirectory within the folder or directory. 

5. When you have completed entering your Include Extension list, click on the Save button (shaped like a floppy disk) to return to the main part of the program.

To use the File List Builder:

1. From the File Explorer selection tool, select the disk volume and directory from which you wish to add files.  A list of files meeting the specific extensions selected earlier will appear in the right window.  If for some reason, one or more of these files should not be selected, select the file in the top right window and then click on the X Selected button to remove it.  Click on the + Add Files button to add all files presently shown in the File Explorer window.

2. If you wish to select an individual file only, select the file and click on the + Selected button.  Alternatively, you may also drag the file from the top window to the bottom window.

3. Browse through directories and subdirectories using the File Explorer controls.  Each time you want more files, add files in a subdirectory using the + Add Files button or selecting the files individually and clicking on the + Selected button.  

4. To add all files in subdirectories under a main directory, first make sure that the Include Subdirectories checkbox is selected.  Next, select the Directory button or pick Add Directory from the Select menu.  All files in the directory and subdirectory of it will be selected.  NOTE: The files located in subdirectories will be shown in the List Manager window below.  They will not be seen in the right side window of the File Explorer.

5. Selecting Clear File List from the Edit menu or click on the Clear File List button on the toolbar will clear all files appearing in the lower List Manager window.

6. When you have selected all files for your list, you are ready to save.  Select Save File List from the File menu of the HiSoftware File List Builder window.  If this is the first time working with this file, you will need to enter a name for your file list and click on the save button.  The program automatically appends the .hfl extension to these files.  By default, the files will save to the LIST TEMP subdirectory of the installation.

7. You can edit your saved list files by selecting Load File List from the File menu.

8. When complete, select Exit List Builder from the File menu.

9. At this point, select the File menu of JITI Builder and then choose Select File.  Select your file list from the location where you saved it.  Most likely, you saved this file in the LIST TEMP subdirectory of the JITI Builder installation.

HiSoftware Profile Builder

Profile Builder assists in creating profiles that can be used in the Search Profile menu of metaSearcher.  Files created with the Profiler Builder have the .mdpf extension.

The Profile Builder is available as a shortcut in the Windows Start menu under the HiSoftware JITI Builder Office program group in the Tools folder.
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An example file is included in the profiles directory and is named sample.mdpf.

· To create a new profile file, select either the New button on the toolbar or select New from the File menu.

· To open a map file, select the Open button on the toolbar or select Open Profile from the File menu.

· To open a map file, select the Save button on the toolbar or select Save Profile from the File menu.

· To add rows and delete rows in the grid, select the Add Row or Del Row buttons from the toolbar.

· To exit the program, select the Exit button from the toolbar or select Exit from the File menu.

· For help, select the Help button from the button on the toolbar.

When saving profiles for use in the metaSearcher Search Profiles, make sure to save the profile to the searchprofiles subdirectory of the JITI Builder Office installation.  Typically, this path is C:\Program Files\HISC\JITI Builder Office but varies depending on what path was chosen for installation. 

Appendix A – Language Codes
These language codes were researched on the MS(R) Site Builder Network Reference Tables.  The following table lists all the possible language codes used to specify various system settings.

· af Afrikaans

· ar-ae Arabic (U.A.E.)

· ar-bh Arabic (Bahrain)

· ar-dz Arabic (Algeria)

· ar-eg Arabic (Egypt)

· ar-iq Arabic (Iraq)

· ar-jo Arabic (Jordan)

· ar-kw Arabic (Kuwait)

· ar-lb Arabic (Lebanon)

· ar-ly Arabic (Libya)

· ar-ma Arabic (Morocco)

· ar-om Arabic (Oman)

· ar-qa Arabic (Qatar)

· ar-sa Arabic (Saudi Arabia)

· ar-sy Arabic (Syria)

· ar-tn Arabic (Tunisia)

· ar-ye Arabic (Yemen)

· be Belarusian

· bg Bulgarian

· ca Catalan

· cs Czech

· da Danish

· de German (Standard)

· de-at German (Austria)

· de-ch German (Switzerland)

· de-li German (Liechtenstein)

· de-lu German (Luxembourg)

· el Greek

· en English

· en English (Caribbean)

· en-au English (Australia)

· en-bz English (Belize)

· en-ca English (Canada)

· en-gb English (Great Britain)

· en-ie English (Ireland)

· en-jm English (Jamaica)

· en-nz English (New Zealand)

· en-tt English (Trinidad)

· en-us English (United States)

· en-za English (South Africa)

· es Spanish (Spain – Modern)

· es Spanish (Spain – Traditional)

· es-ar Spanish (Argentina)

· es-bo Spanish (Bolivia)

· es-cl Spanish (Chile)

· es-co Spanish (Colombia)

· es-cr Spanish (Costa Rica)

· es-do Spanish (Dominican Republic)

· es-ec Spanish (Ecuador)

· es-gt Spanish (Guatemala)

· es-hn Spanish (Honduras)

· es-mx Spanish (Mexico)

· es-ni Spanish (Nicaragua)

· es-pa Spanish (Panama)

· es-pe Spanish (Peru)

· es-pr Spanish (Puerto Rico)

· es-py Spanish (Paraguay)

· es-sv Spanish (El Salvador)

· es-uy Spanish (Uruguay)

· es-ve Spanish (Venezuela)

· et Estonian

· eu Basque

· fa Farsi

· fi Finnish

· fo Faeroese

· fr French (Standard)

· fr-be French (Belgium)

· fr-ca French (Canada)

· fr-ch French (Switzerland)

· fr-lu French (Luxembourg)

· gd Gaelic (Scotland)

· gd-ie Gaelic (Ireland)

· he Hebrew

· hi Hindi

· hr Croatian

· hu Hungarian

· in Indonesian

· is Icelandic

· it Italian (Standard)

· it-ch Italian (Switzerland)

· ja Japanese

· ji Yiddish

· ko Korean

· ko Korean (Johab)

· lt Lithuanian

· lv Latvian

· mk Macedonian

· ms Malaysian

· mt Maltese

· nl Dutch (Standard)

· nl-be Dutch (Belgium)

· no Norwegian (Bokmal)

· no Norwegian (Nynorsk)

· pl Polish

· pt Portuguese (Standard)

· pt-br Portuguese (Brazil)

· rm Rhaeto-Romanic

· ro Romanian

· ro-mo Romanian (Moldavia)

· ru Russian

· ru-mo Russian (Moldavia)

· sb Sorbian

· sk Slovak

· sl Slovenian

· sq Albanian

· sr Serbian (Cyrillic)

· sr Serbian (Latin)

· sv Swedish

· sv-fi Swedish (Finland)

· sx Sutu

· sz Sami (Lappish)

· th Thai

· tn Tswana

· tr Turkish

· ts Tsonga

· uk Ukrainian

· ur Urdu

· ve Venda

· vi Vietnamese

· xh Xhosa

· zh-cn Chinese (PRC)

· zh-hk Chinese (Hong Kong, S.A.R. China)

· zh-sg Chinese (Singapore)

· zh-tw Chinese (Taiwan Region)

· zu Zulu

Thank you for working with HiSoftware TagGen™.  Visit the HiSoftware web site for more knowledge management and web site promotion products.
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